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1. Introduction 
 

1.1 Design with RF-CONCRETE Surfaces 
Although reinforced concrete is as frequently used for plate structures as for frameworks, 
standards and technical literature provide rather little information about the design of two-
dimensional structural components. In particular, shell structures which are characterized 
by a simultaneous loading due to moment and axial force are hardly described in reference 
books. As the finite element method enables a realistic model representation of two-dimen-
sional objects, design theories and algorithms must be found to close this "instructive gap" 
between member-oriented rules and computer-generated internal forces of plate structures. 

DLUBAL ENGINEERING SOFTWARE meets this special challenge with the add-on module RF-CON-
CRETE Surfaces. Based on the compatibility equations by THEODOR BAUMANN from 1972, a 
consistent design algorithm has been developed to dimension two- and three-layer rein-
forcements. To increase the efficiency of this module as a tool used to determine the struc-
turally required reinforcement, RF-CONCRETE Surfaces includes instructions concerning the 
allowable maximum and minimum reinforcement ratios for different structural component 
types (2D plates, 3D shells, walls, wall-like beams), as they can be found in the form of de-
sign specifications defined in the standards. 

In addition to the dimensioning of reinforcing steel, the program always checks if the con-
crete's plate thickness, that stiffens the reinforcement mesh, is sufficient to meet the re-
quirements arising from bending and shear loading. 

In addition to the ultimate limit state design, the serviceability limit state design is possible, 
too. These designs include the limitation of the concrete compressive and the reinforcing 
steel stresses, the minimum reinforcement for the limitation of crack widths as well as the 
limitation of the crack width by limiting rebar diameter and rebar spacing. Here, analytical 
and non-linear design methods are available for selection. 

In the non-linear design (available as additional module), it is possible to take into account 
the influence of creep and shrinkage for the analysis of crack formation in the deformed 
system. 

The design can be carried out according to the following standards: 

• DIN 1045 (1988-07) 
• DIN 1045-1 (2001-07) and (2008-08) 
• DIN V ENV 1992-1-1 (1992-06) 
• ÖNORM B 4700 (2001-06) 
• EN 1992-1-1 
• CSN EN 1992-1-1 
• ÖNORM B 1992-1-1 
• STN EN 1992-1-1 
• UNI EN 1992-1-1 
• NEN EN 1992-1-1 
• BS EN 1992-1-1 
• NF EN 1992-1-1 
• PN EN 1992-1-1 

The seamless documentation of intermediate results, in line with the DLUBAL philosophy, 
provides a special transparency and traceability of design results. 

Your team from DLUBAL ENGINEERING SOFTWARE 
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation and printout are de-
scribed in detail in the manual of the main program RFEM. The present manual focuses on 
typical features of the RF-CONCRETE Surface add-on module. 

The description of the module follows the sequence of the module's input and results tables 
as well as its structure. The theoretical background of the design methods used in this 
module are described in detail in the German manual RF-BETON Flächen. The final manual 
section describes the various program functions for evaluating and documenting the design 
results. 

The text of the manual shows the described buttons in square brackets, for example [New]. 
At the same time, they are pictured on the left. In addition, expressions used in dialog 
boxes, tables and menus are set in italics to clarify the explanations. 

Finally, you find an index at the end of the manual. However, if you don’t find what you are 
looking for, please check our website www.dlubal.com where you can go through our FAQ 
pages. 

1.4 Open the Add-on Module 
RF-CONCRETE Surfaces 

RFEM provides the following options to start the add-on module RF-CONCRETE Surfaces. 

Menu 
To start the program in the menu bar, 

point to Design - Concrete on the Additional Modules menu, and then select 
RF-CONCRETE Surfaces. 

 
Figure 1.1: Menu Additional Modules → Design - Concrete → RF-CONCRETE Surfaces 
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Navigator 
To start the design module in the Data navigator, 

open the Additional Modules folder and select RF-CONCRETE Surfaces. 

 
Figure 1.2: Data navigator: Additional Modules → RF-CONCRETE Surfaces 

Panel 
In case design results are already available in the RFEM structure, you can set the corre-
sponding RF-CONCRETE Surfaces case in the load case list of the RFEM toolbar. By using the 
button [Results on/off], you can display the reinforcements or internal forces in the graphic. 

When the results display is activated, the panel appears showing the button [RF-CONCRETE 
Surfaces] which you can use to open the design module. 

 

Figure 1.3: Panel button [RF-CONCRETE Surfaces] 
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2. Input Data 
All data required for the definition of design cases is entered in tables. The [Pick] function 
allows for a graphical selection of the surfaces that you want to design. 

When you have started the module, a new window opens where a navigator is displayed on 
the left, managing all tables that can be selected currently. The pull-down list above the 
navigator contains the design cases that are already available (see chapter 7.1, page 60). 

If you open RF-CONCRETE Surfaces in an RFEM structure for the first time, the module im-
ports the following design relevant data automatically: 

• Load cases, groups and combinations 

• Materials 

• Surfaces 

• Internal forces (in background, if calculated) 

To select a table, click the corresponding entry in the RF-CONCRETE navigator or page 
through the tables by using the buttons shown on the left. You can also use the function 
keys [F2] and [F3] to select the previous or subsequent table. 

To save the defined settings and quit the module, click [OK]. When you click [Cancel], you 
quit the module but without saving the data. 

2.1 Type of Structure 
The Type of Structure, that you define when you create a new structure, has a considerable 
influence on how the structural components will be stressed. 

 
Figure 2.1: Dialog box New Structure - General Data, dialog section Type of Structure 

When you select the structure type Plate XY, the structural component will be affected only 
by bending. The internal forces to be designed will be exclusively represented by moments 
whose vectors lie in the component's plane. 
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When you select Wall XZ or Wall XY, the structural component will be affected only by com-
pression or by tension in the component's plane. The internal forces used for the design will 
be exclusively represented by axial forces whose vectors lie in the plane of the structural 
component. 

When you set the spatial 3D structure type, both loadings (moments and axial forces) will 
be combined. Therefore, the structural component may be affected by tension/compression 
and bending simultaneously. Thus, the internal forces to be designed will be represented by 
axial forces as well as by moments whose vectors lie in the component's plane. 

 

2.2 General Data 
In table 1.1 General Data, two tabs are available. Use these tabs to determine the loading 
for the Ultimate Limit State and the Serviceability Limit State designs. 

2.2.1 Ultimate Limit State 

 
Figure 2.2: Table 1.1 General Data, tab Ultimate Limit State 

Concrete Design According to Code / National Annex 
In this table, the design standard is defined uniformly for all types of design. The following 
standards for reinforced concrete design can be selected. 

 

Figure 2.3: Selection of design standard 
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If EN 1992-1-1:2004 is set, you can select the National Annex to the right. 

 
Figure 2.4: Selection of national annex 

Use the [Edit] button to check the factors of the selected national annex. If necessary, you 
can adjust the coefficients. 

 
Figure 2.5: Dialog box Eurocode Settings 

You can modify partial and reduction factors, angles of compression struts etc. to consider 
particular national user specifications. 

Click the [New] button to create a copy of the original code. This copy can be modified ap-
propriately and saved as a new Eurocode setting. 

Load Cases / Load Groups and Load Combinations 
These two dialog sections list all load cases, load groups and load combinations defined in 
RFEM that are relevant for the design. Use the button [] to transfer selected load cases, 
groups or combinations to the list Selected for Design on the right. You can also double-
click the entries. To transfer the complete list to the right, use the button []. 
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Load cases that are marked by an asterisk (*) cannot be designed. This may be the case 
when no loads are defined or when the load case contains only imperfections. 

When you design load combinations, please note that in this case, in contrast to the design 
of load cases or load groups, several sets of internal forces instead of a single one may exist 
on the respective design location. Depending on the defined type of structure, up to 16 sets 
of internal forces may be available. The analysis of all maxima and minima including corre-
sponding internal forces affects the calculation speed accordingly. 

Selected for Design 
The column on the right lists the loads selected for the design. Use the button [] to re-
move selected load cases, groups or combinations from the list. You can also double-click 
the entries. With the button [], you can transfer the entire list to the left. 

Comment 
In this input field, you can enter user-defined notes describing in detail, for example, the 
current design case. 

2.2.2 Serviceability Limit State 
To access the tab Serviceability Limit State, you must select at least one action in the Ulti-
mate Limit State tab. The defined standard applies to both tabs. 

 
Figure 2.6: Table 1.1 General Data, tab Serviceability Limit State 
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Load Cases / Load Groups and Load Combinations 
The load cases, groups and combinations (only for analytical design method!) that you 
want to design can be selected in the same way as described in the previous chapter 2.2.1. 

Generally, the actions that are relevant for the serviceability limit state (SLS) are different 
from the ones considered for the ultimate limit state. The appropriate constellations must 
be defined already when superimposing load cases in RFEM. 

Selected for Design 
The column on the right lists the loads selected for the design. As already described in the 
previous chapter, you can use the buttons [] or [] to remove selected or even all load 
cases, groups or combinations from the list. 

Method of Proof 
With the options in the dialog section below the tabs, you decide whether you want to car-
ry out the serviceability limit state designs according to the analytical or the non-linear 
method. 

2.2.2.1 Analytical Method 

The serviceability limit state designs are carried out by default according to the Analytical 
method. This method uses the equations that are valid for the individual standards (for ex-
ample DIN 1045-1, section 11). You find a detailed method description together with an 
example in the theoretical part of the German manual RF-BETON Flächen. 

Use the [Edit Settings] button to open a dialog box where you can specify the settings for 
the calculation of crack widths. 

 
Figure 2.7: Dialog box Settings for Analytical Method of Serviceability Limit State Design 

In the dialog section Method, you decide which deformation ratio of the reinforcement set 
is applied for the serviceability limit state design. By Assuming an Identical Deformation Ra-
tio of the Longitudinal Reinforcement, the program assumes a deformation ratio of 1.0 for 
the inserted reinforcement. This means that the rebars in the individual reinforcement direc-
tions are stressed in the same way. As a complete solution, this approach represents a quick 
and accurate design method. However, the choice of an appropriate inclination for the con-
crete strut plays a decisive role. Furthermore, this method represents a pure geometric dis-
tribution that is described in detail in the theoretical part of the German manual RF-BETON 
Flächen. This approach is applicable when the existing reinforcement corresponds more or 
less to the required reinforcement. 
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The option By Classifying the Macro Element as Plate or Wall offers you a simplified solution 
that you can use for a non-rotated, orthogonal reinforcement mesh. The program checks 
for each design point if the tensile stresses due to axial forces or bending moments exceed 
a certain stress. The corresponding limit value is defined in the dialog section Classification 
Criterion. This criterion is used to classify the relevant surface as plate (axial forces are set to 
zero) or wall (moments are set to zero). By neglecting minor internal force components, it is 
possible to use the flow chart shown in ENV 1992-1-1, annex A 2.8 or 2.9. The design inter-
nal forces are corresponding to the values displayed in the RFEM table 3.12 (cf. RFEM man-
ual, chapter 9.12, page 285). 

If the program cannot fulfill the classification criterion for a design point of the surface, an 
error message appears during the calculation. 

The option By Taking into Account the Deformation Ratio of the Longitudinal Reinforce-
ment is enabled only for the 2D structure types "plate" and "wall" (cf. Figure 2.1, page 8). 
This method considers the effective deformation ratios due to the selected reinforcement 
and takes them into account for the serviceability limit state design. 

The dialog section Classification Criterion is only available for 3D structure types. Use the-
se settings to allow the neglect of minor Normal Forces and/or Bending Moments in order 
to design surfaces, in an idealized way, as pure plates or walls. For both options, the mean 
axial tensile strength fctm with 2.9 N/mm2 of concrete C30/37 is preset as limit value. It is as-
sumed that the tensile strength of concrete compensates a crack formation due to minor 
tensile stresses. This is the reason why they can be neglected. 

If you have selected the simplified surface classification as plate or wall in the Method dia-
log section, you have to tick at least one of the two check boxes. 

In the dialog section Design of, you can determine if the program analyzes stresses and/or 
cracks for the design. You have to tick at least one of the two check boxes. 

When you select Stresses, the program designs the concrete compressive stresses σc and the 
steel stresses σs. When you select Cracks, the module designs the minimum reinforcements 
as,min, the limit diameters lim ds, the maximum crack spacings max sI as well as the crack 
widths wk. The settings for the individual designs are defined in table 1.3 Surfaces (see 
chapter 2.4, page 19). 

In the dialog section Determination of Longitudinal Reinforcement, you decide if the 
longitudinal reinforcement is dimensioned so that the serviceability limit state designs will 
be fulfilled. If the check box is not ticked, the program uses the settings specified in table 
1.4 Reinforcement, tab Longitudinal Reinforcement (see chapter 2.5.3, page 30): applica-
tion of basic reinforcement, required reinforcement or basic reinforcement with additional 
reinforcement. 

The dimensioning of the reinforcement for the serviceability limit state design is determined 
by increasing the reinforcement iteratively. As initial value for the iterations to absorb the 
given characteristic load, the program uses the required ULS reinforcement. The dimension-
ing will have no results if the rebar spacing sI of the applied reinforcement reaches the rebar 
diameter dsl. In this case, the results tables will mark the respective point as non-designable. 
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2.2.2.2 Non-linear Method 

To perform the Non-linear design method, you need a license for the add-on module 
RF-CONCRETE NL. For more theoretical details on this design method, see the German 
manual RF-BETON Flächen. 

The non-linear design method excludes load combinations. The interaction between struc-
ture and load requires a clear distribution of internal forces. In a load combination, howev-
er, maximum and minimum values are available for each FE node. 

Use the [Edit Settings] button in the tab Serviceability Limit State of table 1.1 (see Figure 
2.6, page 11) to open a dialog box where you can define the conditions for the non-linear 
serviceability limit state design. 

 
Figure 2.8: Dialog box Settings for Non-linear Calculation 

In the dialog section Material Properties of Reinforcing Steel, you decide if the calcula-
tion in the plastic range of the reinforcing steel's stress-strain diagram will be carried out 
with a rising or a horizontal graph. 

The settings in the dialog section Options determine if the influence of Creeping and 
Shrinkage is considered in the calculation. In addition, you can decide which serviceability 
limit state designs (deformation, crack widths, stresses) are performed. You have to tick at 
least one of the three check boxes. 

The settings for creeping and shrinkage and all individual designs are defined in table 1.3 
Surfaces (see chapter 2.4.2, page 22). 

In the dialog section Settings for Iteration Process, you define all settings that affect the 
process of the non-linear design method. For more theoretical information on this method, 
see the German manual RF-BETON Flächen. When modifying the accuracy of iterations, take 
care that the Maximum Number of Iterations is higher than the step in the calculation pro-
cess from which the deformation criterion will be taken into account additionally. Use the 
[Details] button to open the RFEM dialog box Calculation Parameters where you can adjust 
the precision of the convergence criteria for the non-linear calculation. 

In the non-linear calculation, the program divides the surface into several Layers. The rec-
ommended number of layers is 10. 
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The dialog box Material Properties of Concrete (cf. Figure 2.8) determines whether a par-
abolic or a parabolic-rectangular graph is applied to the stress-strain diagram of the con-
crete in compression. Furthermore, you can define the concrete's stress-strain diagram in 
tension. In accordance with the CEB-FIB model code, the presetting assumes a non-cracked 
concrete. 

When you select the concrete's stiffening effects in tension (Tension-Stiffening) for the 
stress-strain diagram, you can specify the settings for the application of the tensile strength 
of concrete between the cracks in a separate dialog box. To open the dialog box, use the 
button shown on the left. 

 
Figure 2.9: Dialog box Tension-Stiffening 

More information about tension-stiffening can be found in the German manual RF-BETON 
Flächen. 

The two graphics in the dialog box represent dynamically the modifications of parameters. 
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2.2.3 Details 
If you perform the design according to EN 1992-1-1 or one of the national EN application 
documents, the Details tab is displayed additionally. This tab is unnecessary for serviceability 
limit state designs according to DIN 1045-1 because the factor kt is generally defined with 
0.4 in equation (136), section 11.2.4 (2). 

 
Figure 2.10: Table 1.1 General Data, tab Details 

During the crack width analyses, the program calculates the differences of the mean strains 
of concrete and reinforcing steel. According to equation (7.9) of EN 1992-1-1, section 7.3.4 
(2), the load duration factor kt must be specified for these differences. 

LC, LG or CO Description 
Column A lists all load cases, groups and combinations that have been selected for design 
in the Serviceability Limit State tab. The load cases contained in these load groups and 
combinations appear in this list, too. 

Permanent Load 
This column indicates the load cases that represent permanent loads. If a load case is speci-
fied as permanent load, the factor kt is automatically set to 0.4 in the final column. 

Factor kt 

The load duration factor kt is used to determine the loading period. For a long-term load ac-
tion, the factor is 0.4. For a short-term action, the factor is 0.6. 

For load groups and combinations, the factor kt represents the average of the respective kt 
values of the load cases contained in the corresponding load group or combination. 
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2.3 Materials 
The table is subdivided into two parts. The upper part lists the concrete and steel grades 
used for the design. In the Material Properties section below, the properties of the current 
material, i.e. the table row currently selected in the upper section, are displayed. 

The material properties required for the determination of internal forces in RFEM are de-
scribed in detail in chapter 5.3 of the RFEM manual. The design relevant material properties 
are stored in the global material library and preset automatically. 

To adjust the units and decimal places of material properties and stresses, select Units and 
Decimal Places on the module's Settings menu (see Figure 7.5, page 62). 

 
Figure 2.11: Table 1.2 Materials 

Material Description 
Concrete Strength Class 
The concrete materials defined in RFEM are already preset; different materials are hidden. 
When the Material Description corresponds to an entry of the material library, RF-CON-
CRETE Surfaces will import the appropriate material properties. 

It is possible to select another material by using the list: Place the pointer in a table row of 
column A, and then click the button [] or use the function key [F7]. The list shown on the 
left opens. Subsequent to the transfer, the properties will be updated. 

The list contains only materials of the Concrete category that comply with the design con-
cept of the selected standard. The import of materials from the library is described below. 
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Reinforcing Steel 
In this column, the program presets a common steel grade that corresponds to the design 
concept of the selected standard. 

It is possible to select another reinforcing steel by using the list: Place the pointer in a table 
row of column B, and then click the button [] or use the function key [F7]. The list shown 
on the left opens. Subsequent to the transfer, the properties will be updated. 

The import of materials from the library is described below. 

Material Library 
Numerous concrete and reinforcing steel materials are stored in the library. To open the li-
brary, use the button shown on the left. The button can be found below column A and B. 

 
Figure 2.12: Dialog box Material Library 

The standard relevant materials are already preset in a preselection so that no other catego-
ries or standards are available in the Filter Choice dialog section. Select a material from the 
list Material to Select and check the corresponding parameters in the lower part of the dia-
log box. Basically, it is not possible to edit these material properties. 

Click [OK] or use the [↵] button to import the selected material to table 1.2 of the add-on 
module. 

Chapter 5.3 in the RFEM manual describes in detail how materials can be added or rear-
ranged. By using the [Create New Material] button, you can create a new concrete or rein-
forcing steel with user-defined material properties and store it for later use. 
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2.4 Surfaces 
In this table, the surfaces that you want to design are listed. In addition, you can define the 
settings for the serviceability limit state design, provided that you have selected at least one 
action in the Serviceability Limit State tab of table 1.1 General Data (cf. Figure 2.6, page 
11). 

The table's appearance depends on the design method that has been specified for the ser-
viceability limit state designs (SLS) in table 1.1. When you design the ultimate limit state ex-
clusively, only the thicknesses of the respective surfaces are listed. 

2.4.1 Analytical Method for SLS 

 
Figure 2.13: Table 1.3 Surfaces with settings of the analytical design method for the serviceability limit state 

Material No. 
For each surface, the table shows the material numbers that are managed in table 1.2 
Materials. The assigned materials cannot be changed in this table. 

Thickness 
Type 
As additional information, the table displays the thickness types that have been assigned in 
RFEM. The program is able to design constant and linearly variable thicknesses as well as or-
thotropic surfaces (without non-linear method for SLS). 

d 
This column shows the thicknesses that have been imported from RFEM. It is always possi-
ble to modify the preset values for the design. 

Please note that the design will be carried out with the internal forces determined in RFEM 
which refer to the stiffnesses of the surface thicknesses defined in the main program. In 
case of a statically indeterminate structure, the surface thicknesses modified in RF-CON-
CRETE Surfaces must be adjusted in RFEM, too, in order to ensure a correct design. 
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The number of the subsequent table columns depends on the tabs displayed in the lower 
table part. The tabs are determined by the settings in the Settings dialog box that you can 
access in the Serviceability Limit State tab of table 1.1 General Data (see Figure 2.7, page 
12). In this dialog box, you can decide whether the program designs stresses and/or cracks. 

The values cannot be entered directly into the columns, but are determined by the tab set-
tings in the lower table part. Please note that, by default, the tab specifications apply exclu-
sively to the surface selected in the upper table part. It is possible, however, to assign the 
current specifications to another surface, or to all surfaces or only some of them. In this 
case, tick the check box Set Inputs for Surface No and clear the All check box to the right 
(cf. Figure 2.13). Then you can enter the numbers of the relevant surfaces manually. You 
can also select them graphically in the RFEM work window. If you want to apply the set-
tings to all surfaces, tick the All check box. Finally, click the button [] to assign the specifi-
cations to the selected surfaces. The assignment is only applicable for the current tab (for 
example Stress Proof). 

σc,min 
This column shows the respective value of the minimum concrete stress for the limitation of 
the concrete pressure stresses. According to DIN 1045-1, the following applies to 

- quasi-permanent action combination, if serviceability, ultimate limit state or durability 
are considerably affected by creeping: 
 σc ≤ 0.45 · fck 

- rare action combination in exposure classes XD1 to 3, XF1 to 4, XS1 to 3: 
 σc ≤ 0.60 · fck 

The parameters are defined in the Stress Proof tab (see Figure 2.15). 

σs,max 
This value represents the maximum reinforcing steel stress for the limitation of the rein-
forcement's tensile stresses. According to DIN 1045-1, the following applies to 

- rare action combination: 
 σs ≤ 0.80 · fyk 

- exclusive effects due to restraint: 
 σs ≤ 1.00 · fyk 

The parameters are defined in the Stress Proof tab (see Figure 2.15). 

fct,eff 
This column displays the respective value of the effective tensile strength of the concrete. 
This value is required to control the rebar diameter. 

The parameters are defined in the tab Limit of Crack Widths (see Figure 2.13). In this tab, 
you can also specify detail settings concerning the minimum reinforcement for effects due 
to restraint by using the [Edit] button. 
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Figure 2.14: Dialog box Further Settings for Min. Reinforcement due to Restraint 

wk,max 
This value represents the maximum allowable crack width. 

The parameters are defined in the tab Limit of Crack Widths (see Figure 2.13). 

Remark 
This column shows remarks in the form of footers that are described in detail in the status 
bar. 

Comment 
This input field can be used to enter user-defined comments. 
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2.4.2 Non-linear Method for SLS 

To design according to the non-linear method, a license of the add-on module 
RF-CONCRETE NL is required. 

 
Figure 2.15: Table 1.3 Surfaces with settings of the non-linear design method for the serviceability limit state 

The table columns Material and Thickness are similar to the ones in the analytical design 
method. They are described in the previous chapter 2.4.1 on page 19. 

The values of the subsequent columns cannot be entered directly, but are determined by 
the tab settings in the lower table part. Please note that, by default, the tab specifications 
apply exclusively to the surface selected in the upper table part. It is possible, however, to 
assign the current specifications to another surface, or to all surfaces or only some of them. 
In this case, tick the check box Set Inputs for Surface No and clear the All check box to the 
right. Then you can enter the numbers of the relevant surfaces manually. You can also se-
lect them graphically in the RFEM work window. If you want to apply the settings to all sur-
faces, tick the All check box. Finally, click the button [] to assign the specifications to the 
selected surfaces. The assignment is only applicable for the current tab. 

Creep Ratio ϕ 
The parameters for creeping are defined in the Creeping tab. Based on these conditions, 
RF-CONCRETE NL determines the creep ratio. For the effective thickness of the structural 
component h0, the program assumes the surface thickness d for the calculation. 
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Figure 2.16: Dialog section Settings for the Proof of Serviceability Limit State, tab Creeping 

The determination of the creep ratio ϕ is described in detail in the German manual 
RF-BETON Flächen. 

Shrinkage εcs (in preparation) 
This column displays the respective shrinkage. The corresponding parameters are defined in 
the Shrinkage tab. Based on these conditions, the program determines the appropriate 
shrinkage automatically. For the effective thickness of the structural component h0, the 
program assumes the surface thickness d for the calculation. 

 
Figure 2.17: Dialog section Settings for the Proof of Serviceability Limit State, tab Shrinkage 

The determination of the shrinkage εcs is described in detail in the German manual 
RF-BETON Flächen. If you do not want to apply any strain due to shrinkage for particular 
surfaces, set 0 ‰ for the user-defined shrinkage in the Shrinkage tab. 

Please note that you cannot consider any shrinkage for the structure type Plate XY (cf. Fig-
ure 2.1, page 8) because this type provides degrees of freedom only for bending. 

uz,max 
This value represents the maximum allowable deformation that must be observed for the 
serviceability limit state design. The corresponding parameters are defined in the Defor-
mation Analysis tab. 
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Figure 2.18: Table 1.3 Surfaces, tab Deformation Analysis 

To ensure the serviceability limit state for common structures, for example according to DIN 
1045-1, the deflection due to the quasi-permanent action combination must not exceed the 
following limit values: 

• common case     
250
l

u eff
maxz, =  

• structural components for which excessive 
deformations can result in subsequent damages 

The selection fields Minimal Border Line, Maximal Border Line and User-defined Relative de-
termine the length that is used for leff. For the two border line options, the program applies 
the shortest or longest border line of the respective surface (see Figure 2.19). For the user-
defined relative specification, you can enter the length directly or select it graphically be-
tween two points in the RFEM structure. For all three options, you must define a divisor by 
which the defined lengths will be divided. 

When you select User-defined Absolute, you can specify the allowable maximum defor-
mation uz,max directly. 

 

Figure 2.19: Border lines for the determination of uz,max 
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The deformation design criterion takes into account the sag of a surface, that means the 
"vertical deformation relative to the shortest line connecting the points of support". There-
fore, three options are available in the lower part of the Deformation Analysis tab (Figure 
2.18). You can decide on how the locally applied deformation uz,local should be calculated 
for the deformation analysis. 

• Undeformed System: The deformation is related to the initial structure. 

• Displaced Parallel Surface: In case of a semi-rigid support of the surface, select this 
option to consider the existing deformation. The defor-
mation uz,local refers to a virtual reference surface that is 
displaced parallel to the undeformed system. The dis-
placement vector of this reference surface is as long as 
the minimal nodal deformation within the surface. 

 

Figure 2.20: Displaced parallel surface at position of minimal deformed node 

• Deformed Reference Plane: In case the support deformations of a surface differ con-
siderably from each other in size and degree, you can de-
fine a slanted reference plane to which the deformation 
uz,local is related. This plane is defined by three points of 
the undeformed system. Then, RF-CONCRETE NL calcu-
lates the deformation of the three definition points and 
places the reference plane in the displaced points in or-
der to calculate the local deformation uz,local. 

 

Figure 2.21: Displaced user-defined reference plane 
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wk,max 
This value represents the maximum allowable crack width. 

The parameters are defined in the tab Crack Width Control (cf. Figure 2.13). 

σc,min 
High concrete pressure  and reinforcing steel stresses in the serviceability limit state affect 
the serviceability and durability adversely. This table column shows the respective value of 
the minimum concrete stress for the limitation of the concrete pressure stresses. 

The parameters are defined in the Stress Proof tab (see Figure 2.15). 

σs,max 
This value represents the maximum reinforcing steel stress for the limitation of the rein-
forcement's tensile stresses. 

The parameters are defined in the Stress Proof tab (see Figure 2.15). 

2.5 Reinforcement 
This table consists of five tabs where all reinforcement data is specified. As the individual 
surfaces often require different settings, you can create several reinforcement groups for 
each RF-CONCRETE Surfaces case. The reinforcement definitions can be entered surface by 
surface. 

Reinforcement groups 
To create a new reinforcement group, use the [New] button in the dialog section Rein-
forcement Group. The number is allocated by the program. The user-defined Description 
helps you to overlook all reinforcement groups created in the design case. 

 
Figure 2.22: Table 1.4 Reinforcement with three reinforcement groups 

To select a reinforcement group, use the No. list or the entries in the navigator. 
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By using the [Delete] button, the currently selected reinforcement group is deleted from the 
RF-CONCRETE Surfaces case without any additional warning. Surfaces that were contained 
in such a reinforcement group won't be designed. To design those surfaces, you must reas-
sign them to a new or an existing reinforcement group. 

In the dialog section Applied to Surfaces, you determine the surfaces to which the current 
reinforcement group is applied. All surfaces are preset. If the check box is ticked, no further 
reinforcement group can be created because surfaces cannot be assigned to different rein-
forcement specifications. Therefore, clear the All check box if you want to use several rein-
forcement groups. 

In the input field below, you can enter the numbers of the relevant surfaces manually. You 
can also use the [Pick] button to select them graphically in the RFEM work window. Further-
more, the button [Create New Reinforcement Group] is enabled. Only surface numbers that 
have not yet been assigned to other reinforcement groups are allowed to be entered in the 
input field. 

2.5.1 Reinforcement Ratios 

 
Figure 2.23: Table 1.4 Reinforcement, tab Reinforcement Ratios 

This tab defines the minimum and maximum reinforcements in percentage. The Minimum 
Secondary Reinforcement is related to the maximum longitudinal reinforcement that is to 
be applied. All further specifications are set in relation to the cross-section area of a surface 
stripe with the width of one meter. An exception represents the Minimum Compression Re-
inforcement according to DIN 1045-88 that is related to the statically required cross-section. 

Find examples for the minimum and maximum reinforcements in the German manual 
RF-BETON Flächen. 

To perform wall-specific designs, for example according to DIN 1045-1, section 13.7, or 
EN 1992-1-1, section 9.6, select the option Proof of surfaces as walls. Depending on the 
standard selected in table 1.1 General Data, the program takes into account criteria of the 
minimum reinforcements for walls. 
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2.5.2 Reinforcement Layout 

 
Figure 2.24: Table 1.4 Reinforcement, tab Reinforcement Layout 

This tab determines the geometric reinforcement specifications of the reinforcement group. 

Number of Layers 
The reinforcement mesh can be applied in the form of two or three reinforcement layers for 
each surface side. For serviceability limit state designs, only a two-layer reinforcement mesh 
is allowed. 

The definition of the "top" and "bottom" side of the surface can be found in the description 
of the concrete covers below. 

Refer Concrete Cover to 
The concrete covers defined in the following can be related to the reinforcement's Centroid 
or Edge distance . 

 
Figure 2.25: Relations of concrete cover 

When you design only the ultimate limit state and you select the second option, you must 
specify the Bar Diameter D. In the dialog section below, you define the edge distance c (that 
means the nominal value of the concrete cover cnom). 
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Concrete Covers 
In these input fields, you specify the concrete covers for both surface sides. The dimensions 
represent either the centroids of the individual layers or the reinforcements' edge distances 
cnom in direction ϕ1. The reinforcement directions are defined in the dialog section below. 

The "top" and "bottom" surface side is defined as follows: The bottom side is defined in di-
rection of the positive local surface axis z, the top side is defined accordingly in direction of 
the negative local axis z. To display the surface axes, use the Display navigator in RFEM and 
select the entries Structure → Surfaces → Surface Axis Systems x,y,z. You can also use the 
context menu of the corresponding surface. 

If you want to reverse the local z-axis of a surface, right-click the corresponding surface in 
the RFEM work window to open its context menu. Then select Reverse Local Axis System. In 
this way, it is possible to unify, for example, the orientations of walls and to assign the top 
and bottom reinforcement sides for surfaces in vertical position appropriately. 

If the structure in RFEM was created with the structure type Wall (cf. Figure 2.1, page 8), it 
is not possible to generate different reinforcement meshes for both surface sides. In this 
case, the module allows only for input options concerning uniform concrete covers so that 
they can be applied synchronously to both surface sides. 

Reinforcement Directions 
The reinforcement directions ϕ refer respectively to the local x-axis of the finite elements in 
the surfaces' results axis system. The angle ϕ must be entered with a positive value. It repre-
sents the clockwise rotation of the reinforcement direction in relation to the corresponding 
x-axis. 

The results axis system belongs to the surface's properties which can be edited and adjust-
ed, if necessary, in the RFEM dialog box Edit Surface. 

 
Figure 2.26: RFEM dialog box Edit Surface, tab Axes 

The axes of the finite elements can be checked graphically in the RFEM work window by se-
lecting the following entries in the Display navigator: FE Mesh → On Surfaces → FE Axis Sys-
tems x,y,z or Numbering → FE Mesh → FE Axis Systems x,y,z (cf. Figure 9.30 on page 281 in 
the RFEM manual). 

 
 
Top and Bottom layers 
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If the structure in RFEM was created with the structure type Wall (cf. Figure 2.1, page 8), it 
is not possible to generate different reinforcement meshes for both surface sides. In this 
case, the module allows only for input options concerning uniform directions of the rein-
forcement sets so that they can be applied synchronously to both surface sides. 

2.5.3 Longitudinal Reinforcement 

 
Figure 2.27: Table 1.4 Reinforcement, tab Longitudinal Reinforcement for ultimate and serviceability limit state designs 

The tab's appearance depends on the designs that you want to perform: For the serviceabil-
ity limit state designs (SLS), you must specify reinforcement areas. If you want to carry out 
the ultimate limit state design exclusively, no specific reinforcement settings are required. 
You only need to decide which longitudinal reinforcement you want to use for the shear 
design. 

For more information on the reinforcement specifications for the SLS design, see the Ger-
man manual RF-BETON Flächen. 

Provided Basic Reinforcement 
For each surface side and each reinforcement direction, you can define a basic reinforce-
ment that will be inserted respectively in all surfaces of the reinforcement group. In the cor-
responding input fields, enter the Reinforcement Area and the Diameter that is relevant for 
the serviceability limit state design. 

If the user-defined basic reinforcement exceeds the maximum required reinforcement, no 
additional reinforcement is needed. However, big basic reinforcements are usually not ap-
plied to surfaces because this would not be efficient. 

Entering reinforcement areas is facilitated by libraries that are available for rebars and mesh 
reinforcements. To access these libraries, use the two buttons shown on the left. 

In the libraries (cf. Figure 2.28 and Figure 2.29), you can select rebars or reinforcing steel 
meshes. The reinforcement areas defined or stored in the libraries can be transferred to the 
input fields of the dialog section. 
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Libraries 

 
Figure 2.28: Dialog box Import Reinforcement Area due to Rebar 

The three selection fields in the dialog section Rebar Parameters are interactive. Normally, 
the program determines the reinforcement area from the rebar diameter and the rebar 
spacing. 

In the dialog section Export, you decide in which input fields of the initial dialog box the 
determined reinforcement areas will be imported. The location as well as the reinforcement 
direction can be defined specifically (or generally by ticking all check boxes). 

 
Figure 2.29: Dialog box Import Reinforcement Area from Mesh Reinforcement Library 

First, select the Product Range from the list shown on the left. Then, define the mesh Type 
and select the relevant Number in the dialog section to the right. In the dialog section be-
low, you can check the Mesh Reinforcement Properties. 

In the dialog section Export, you decide in which input fields of the initial dialog box the 
determined reinforcement areas will be imported. The location as well as the reinforcement 
direction can be defined specifically (or generally by ticking all check boxes). 
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Use Required Reinforcement for Design of Serviceability 
The ideal way to perform serviceability limit state designs would be the following: 

1. Determine the required reinforcement by using only the load specified in the Ultimate 
Limit State tab 

2. Create a reinforcement drawing by considering the colored result diagram including 
mesh reinforcements and rebars 

3. If necessary, divide the surfaces in RFEM on the basis of the reinforcement drawing into 
smaller surfaces that have the same existing reinforcement area in each reinforcement 
direction 

4. Define the existing reinforcement area, rebar spacing and diameter for each surface in 
the add-on module RF-CONCRETE Surfaces 

5. Calculate once again with the loads of the Serviceability Limit State tab 

This procedure seems to be time-consuming and, in some way, is contrary to the program's 
convention indicating that you can determine the reinforcement and perform the servicea-
bility limit state designs by simply using the [Calculation] button. 

Therefore, you can tick the check box Use Required Reinforcement to quickly get a provided 
reinforcement for the individual surfaces: The program uses the required reinforcement 
from the ultimate limit state design as the reinforcement that is to be applied. When the 
check box is ticked, you only need to specify the rebar diameter. 

Additional Reinforcement 
This dialog section is only available for the serviceability limit state design. 

In the areas where the statically required reinforcement exceeds the defined basic rein-
forcement, an additional reinforcement is needed. Use the selection list in this dialog sec-
tion to define the additional reinforcement that you want to apply for the serviceability lim-
it state design.  

If you select Required Additional Reinforcement, the program assumes the effective As,req 

distribution as the additional reinforcement to be applied. 

If you select Layed out Additional Reinforcement, the program determines the additional re-
inforcement as the difference from the maximum statically required reinforcement and the 
defined basic reinforcement. 

as,add = max as,req – as,basic 

Equation 2.2 

The additional reinforcement is dimensioned as shown in the graphical representation be-
low. 

 
Figure 2.30: Dimensioning of additional reinforcement 

To dimension the additional reinforcement, you only need to specify the rebar diameter. 
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You can also enter a User-defined Additional Reinforcement. If you chose this setting, the 
two library buttons shown on the left will be enabled so that rebars and mesh reinforce-
ments are available for selection. 

The [Info] button opens a dialog box where all three options described above are visualized. 

Longitudinal Reinforcement for Proof of Shear Resistance 
In the last dialog section, three options are available to define the applied longitudinal rein-
forcement for the shear design without shear reinforcement. 

• Apply required longitudinal reinforcement 

The design of shear force resistance is carried out with the transformed existing ten-
sion reinforcement in direction of the principal shear force. 

• Automatically increase required longitudinal reinforcement to avoid shear reinforce-
ment 

In case the required longitudinal reinforcement is not sufficient for the shear force re-
sistance, the longitudinal reinforcement will be increased in the principal shear force 
direction until the shear design without shear reinforcement is fulfilled. 

• Apply the greater value resulting from either required or defined provided reinforce-
ment 

For the design of shear force resistance, the program uses either the statically required 
or the user-defined longitudinal reinforcement. 
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2.5.4 Design Method 

 
Figure 2.31: Table 1.4 Reinforcement, tab Design Method 

When determining the required reinforcement, the principal internal forces are transformed 
into design forces in direction of the reinforcement and in a related concrete strut force. 
The sizes of these design forces depend on the presumed angle of the concrete compres-
sion strut that stiffens the reinforcement mesh. 

In the load situations "tension-tension" and "tension-compression", the design force may be-
come negative in one reinforcement direction for specific angles of compression struts. That 
means that compressive forces would occur for the tension reinforcement. Due to the op-
timization of design forces, the direction of the concrete compression strut is modified until 
the negative design force is zero. 

During the optimization process of internal forces, the program determines the inclination 
angle of the concrete strut that produces the most favorable design result. The design mo-
ments are determined iteratively with adjusted inclination angles in order to find the ener-
getic minimum with the least required reinforcement. The optimization process including 
an example is described in detail in the German manual RF-BETON Flächen. 

The optimization for concrete components subjected to compression such as walls may re-
sult in non-designable elements due to failure of the compression strut. Therefore, the op-
timization is possibly not adequate for the load situation "compress-compression". 
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2.5.5 Standard 
The final table tab is reserved for the standard which you have selected in table 1.1 General 
Data. In this tab, the standard-specific reinforcement data is defined. In the following, spec-
ifications for DIN 1045-1 are described. 

At the bottom right below the table, two buttons are available. Click [Default] to reset the 
initial values of the current standard. Use [Set As Default] to store the defined entries as 
new default settings. 

 
Figure 2.32: Table 1.4 Reinforcement, tab DIN 1045-1 

Various 
In this dialog section, the depth of the neutral axis can be limited according to DIN 1045-1, 
section 8.2 (3). In this case, the maximum ratio is xd / d = 0.45 for concrete up to strength 
class C50/60 and xd / d = 0.35 for concrete from strength class C55/67. 

Factors 
In the first two input fields, the Partial Safety Factors for concrete γc and for reinforcing 
steel γs are defined. The values according to DIN 1045-1, table 2, are preset. 

The value that is recommended in DIN 1045-1, section 9.1.6 (2), is preset as reduction fac-
tor α that is used to consider long-term effects on the concrete compressive strength. 

Shear Reinforcement 
Use the two input fields in this dialog section to define the allowable range of the concrete 
struts' inclination. In case the entered angles are outside the allowed limits mentioned in 
the standards, an error message appears. 
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3. Calculation 
To start the calculation, click the [Calculation] button. 

The reinforced concrete design is carried out by using the internal forces that have been de-
termined in RFEM. If the RFEM results are not yet available, the program starts the calcula-
tion of the internal forces automatically. 

3.1 Check 
Before you start the calculation, it is recommended to check the input data of the add-on 
module RF-CONCRETE Surfaces for correctness. The [Check] button is available in each input 
table of the module and is used to start the check. 

The program checks if the data required for the design is complete and if the references of 
the data sets are alright. In case input errors are detected, you can access the corresponding 
table directly to make corrections. 

If the plausibility check has been successful, the following message appears. 

 
Figure 3.1: Plausibility check of input data 

3.2 Start Calculation 
You can start the calculation out of each of the four input tables by clicking the [Calcula-
tion] button. 

RF-CONCRETE Surfaces searches for the results of the load cases, load groups and load 
combinations that you want to design. If they cannot be found, the program starts the 
RFEM calculation to determine the design relevant internal forces. In this determination 
process, the calculation parameters preset in RFEM are applied. 

It is also possible to start the design in the RFEM user interface. The add-on modules are 
listed in the dialog box To Calculate like load cases or load groups. To open the dialog box 
in RFEM, 

select To Calculate on the Calculate menu. 
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Figure 3.2: Dialog box To Calculate 

If the design cases of RF-CONCRETE Surfaces are missing in the Not Calculated list, tick the 
check box Show Additional Modules. 

To transfer the selected RF-CONCRETE Surfaces cases to the list on the right, use the button 
[]. Start the calculation by using the [Calculate] button. 

You can also use the list in the RFEM toolbar to calculate the RF-CONCRETE Surfaces cases 
directly: Select the relevant design case and click the button [Results on/off]. 

 
Figure 3.3: Direct calculation of an RF-CONCRETE Surfaces design case in RFEM 

Subsequently, you can observe the calculation process in a separate dialog box. 

 
Figure 3.4: RF-CONCRETE Surfaces calculation 
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4. Results 
Table 2.1 Required Reinforcement Total is displayed immediately after the calculation. Re-
sults tables 2.1 to 2.3 list the results of the ultimate limit state design including descrip-
tions. Tables 3.1 to 3.3 are reserved for the results of serviceability limit state designs. Use 
the RF-CONCRETE Surfaces navigator to access the relevant results table. You can also use 
the two buttons shown on the left or the function keys [F2] and [F3] to select the previous 
or subsequent table. 

Click [OK] to save the results and quit the add-on module RF-CONCRETE Surfaces. 

In the following, the different results tables are described in sequence. Evaluating and 
checking results is described in detail in chapter 5 Results Evaluation on page 51. 

By selecting one of the options below the results tables you can decide whether the results 
data is displayed In FE-Nodes or In Grid Points in the individual tables. The results of the FE 
points are determined directly by the analysis core. The grid point results are determined by 
interpolation of the FE point results. 

The results tables 3.1 to 3.3 are subdivided into two parts (cf. Figure 4.5). The upper part 
represents a design overview in tables. The lower part displays the intermediate results of 
the current FE or grid point (that means the entry selected above) including all design rele-
vant parameters. The different chapters of the tree structure in the lower table part can be 
opened by clicking [+] and closed by clicking [-]. 

4.1 Required Reinforcement Total 

 
Figure 4.1: Table 2.1 Required Reinforcement Total 

The table shows the maximum reinforcement results of all surfaces provided for the design. 
The output data is determined from the internal forces of the load cases, load groups and 
load combinations selected for the ultimate limit state design. 
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Point No. 
This table column displays the numbers of the FE or grid points where the maximum re-
quired reinforcement for each position and direction has been determined. The reinforce-
ment type is displayed in column E Symbol. 

The FE mesh points are generated automatically. The grid points represent a property of the 
surface that can be set in RFEM. For each surface you can create user-defined results grids. 
For detailed information on grid points, see the RFEM manual, chapter 9.9, page 277. 

Point-Coordinates 
The three columns contain the coordinates of the governing FE or grid points. 

Symbol 
Column E displays the reinforcement type. For the four (or six) longitudinal reinforcements, 
the module shows respectively direction (1, 2 and 3, where applicable) and surface side (top 
and bottom). 

The reinforcement directions are defined in the Reinforcement Layout tab of table 1.4 Rein-
forcement (cf. chapter 2.5.2, page 28). 

The bottom reinforcement layer is defined on the surface side in direction of the positive lo-
cal surface axis z. Accordingly, the top reinforcement layer is defined in direction of the 
negative z-axis. 

The shear reinforcement is indicated as asw. 

Required Reinforcement 
This column displays the reinforcement areas that are required for the ultimate limit state 
design. 

Basic Reinforcement 
This column contains the user-defined basic reinforcement that has been specified in the 
Longitudinal Reinforcement tab in table 1.4 Reinforcement (cf. chapter 2.5.3, page 30). 

Additional Reinforcement 
When you design the ultimate limit state exclusively, column H displays the difference be-
tween required reinforcement (column F) and existing basic reinforcement (column G). 

When you design the serviceability additionally, you see in table column I the reinforcement 
areas that are required by the specifications in the Longitudinal Reinforcement tab of table 
1.4 Reinforcement (cf. chapter 2.5.3, page 30) to fulfill the serviceability limit state designs. 

Remark 
The final column indicates non-designable situations or notes referring to design problems. 
The numbers are explained in the status bar. 

To display all messages of the currently selected design case, use the [Messages] button 
shown on the left. A dialog box with relevant information appears. 

 
Figure 4.2: Dialog box Error Messages or Notes 

 
 

Top and Bottom layers 
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The buttons below the table are reserved for the following functions: 

Button Description Function 

 Filter Points 
FE and grid points can be filtered by surfaces and ac-
cording to certain criteria. 
 chapter 5.3, page 55  

 
Only Designable 
Results 

Table rows with non-designable elements are hidden. 

 Find Point 
You can search for table rows with results of single FE or 
grid points by specifying surface or number. 
 chapter 5.3, page 57  

 Pick Surface 
You can click a surface in the RFEM window to display 
its results in the table. 

 View mode 
You can jump to the RFEM work window to set another 
view. 

Table 4.1: Buttons of results tables 2.1 to 2.3 

When you display the design results In Grid Points (see Figure 4.1), the button [Des.-Details] 
is enabled. Use this button to check the design details of each grid point. The display refers 
to the selected grid point, that means the table row where the pointer is currently placed. 

The design details are displayed only for the results of load cases and load groups. The dia-
log box Design Details is described in chapter 5.1 on page 51. 

4.2 Required Reinforcement By Surface 

 
Figure 4.3: Table 2.2 Required Reinforcement By Surface 

This table shows the maximum reinforcement areas that are required for each of the de-
signed surfaces. Details on the table columns can be found in the previous chapter 4.1. 
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4.3 Required Reinforcement By Point 

 
Figure 4.4: Table 2.3 Required Reinforcement By Point 

This table lists the maximum reinforcement areas for all FE or grid points of each surface. 
The different columns are described in detail in chapter 4.1 on page 39. 

In addition to the table rows showing the various reinforcement types, the table displays 
significant values that are important for the determination of the reinforcement. For the 
standard DIN 1045-1, these are the following: 

Symbol Meaning 

n1 top 
Axial force or membrane force for design of reinforcement in first 
reinforcement direction on top side of the surface 

n2 top 
Axial force or membrane force for design of reinforcement in second 
reinforcement direction on top side of the surface 

n1 bottom Same as n1 top, but on bottom side of the surface 

n2 bottom Same as n2 top, but on bottom side of the surface 

m1 top / m2 top 
Only for structure type Plate XY: Moment for design of reinforcement 
in first or second reinforcement direction on top side of the surface 

m1 bottom / m2 bottom Same as m1 top / m2 top, but on bottom side of the surface 

VEd Design value of applied shear force 

VRd,ct Design shear resistance without shear reinforcement 

VRd,max Design shear resistance of concrete compression strut 

VRd,sy Design shear resistance of shear reinforcement 

Theta Inclination angle of concrete compression strut θ 

Table 4.2: Output values in table 2.3 for DIN 1045-1 

The search function that you can use by clicking the button shown on the left helps you to 
find specific FE or grid points quickly (cf. Figure 5.8, page 57). 
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4.4 Serviceability Total 

 
Figure 4.5: Table 3.1 Total 

This table shows the governing results of the various serviceability limit state designs of all 
surfaces provided for the design. It is subdivided into two parts: The upper part represents a 
design overview in tables. The lower part displays the Intermediate Results of the FE or grid 
point selected above. 

Figure 4.5 shows the results table of an analytical serviceability limit state design. The de-
sign method is defined in the Serviceability Limit State tab of table 1.1 General Data (cf. 
Figure 2.6, page 11). Chapter 4.7 on page 47 describes the results tables that appear when 
a non-linear SLS analysis was carried out. 

Point No. 
This table column displays the numbers of the FE or grid points for which the program has 
determined the maximum ratios for each required design. The design type is displayed in 
column F Type. 

The FE mesh points are generated automatically. The grid points represent a property of the 
surface that can be set in RFEM. For each surface you can create user-defined results grids. 
For detailed information on grid points, see the RFEM manual, chapter 9.9, page 277. 

Point-Coordinates 
These three columns contain the coordinates of the governing FE mesh or grid points. 

Load Case 
Table column E displays the load case, load group or load combination whose internal forc-
es produce the maximum ratio for the respective serviceability limit state design. 

Type 
Column F shows the type of the serviceability limit state design. If the analytical method 
was used, the column lists up to six design types. These types are described in detail includ-
ing example in the German manual RF-BETON Flächen. 
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The individual design types have the following meanings: 

Type Design SLS 

σc 
Limitation of concrete compressive stress according to specifications in table 
1.3 Surfaces (see Figure 2.15, page 22) 

σs 
Limitation of reinforcing steel stress according to specifications in table 
1.3 Surfaces (see Figure 2.15, page 22) 

as,min 
Minimum reinforcement for the limitation of crack widths according to specifi-
cations in table 1.3 Surfaces (see Figure 2.13, page 19 and Figure 2.14, page 21) 

lim ds 
Limitation of rebar diameter according to specifications in table 1.4 Reinforce-
ment (see Figure 2.27, page 30) 

lim sl 
Limitation of rebar spacing according to specifications in table 1.4 Reinforce-
ment (see Figure 2.27, page 30) 

wk 
Limitation of crack widths according to specifications in table 1.3 Surfaces 
(see Figure 2.13, page 19) 

Table 4.3: Serviceability limit state designs according to analytical method 

This Existing Value 
This table column displays the total extreme values of all surfaces that are decisive for the 
respective serviceability limit state designs. 

Limit Value 
The limit values result from the standard specifications and the current load situation. The 
determination of the limit values is described in detail in the German manual RF-BETON 
Flächen. 

Ratio 
This column represents the design quotients from the existing (column G) and the limit val-
ue (column H). In this way, you can find out immediately whether the design criterion of 1 
has been fulfilled or exceeded. 

In the background of this table column, colored scales  are displayed whose lengths reflect 
the ratio of the area. A green scale means that the design is fulfilled. A red scale indicates 
an exceeding. To display or hide the scales in the table, use the button shown on left. 

Note 
The final column indicates non-designable situations or notes referring to design problems. 
The numbers are explained in the status bar. 

To display all messages of the currently selected design case, use the [Messages] button 
shown on the left. A dialog box with relevant information appears (cf. Figure 4.2, page 39). 
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The buttons in the upper part of the table are reserved for the following functions: 

Button Description Function 

 Sorting of Results 
The results can be arranged according to maximum 
ratios (column J) or values (column G). 
 chapter 5.3, page 56 

 Filter Points 
FE and grid points can be filtered by surfaces and ac-
cording to certain criteria. 
 chapter 5.3, page 55  

 
Only Designable 
Results 

Table rows with non-designable elements are hidden. 

 
Show Ratios with 
Ratio > 1 

The table shows only rows with ratios > 1.00. 

 Find Point 
You can search for table rows with results of single FE 
or grid points by specifying surface or number. 
 chapter 5.3, page 57  

 Pick Surface 
You can click a surface in the RFEM window to display 
its results in the table. 

 Print results 
The intermediate results of the current FE or grid point 
are printed in the printout report. 

 Show Color Bars 
The colored reference scales can be displayed or hid-
den. 

 View mode 
You can jump to the RFEM work window to set anoth-
er view. 

Table 4.4: Buttons of results tables 3.1 to 3.3 

When you display the design results In Grid Points (see Figure 4.1), the button [Des.-Details] 
is enabled. Use this button to check the design details of each grid point. The display refers 
to the selected grid point, that means the table row where the pointer is currently placed. 
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4.5 Serviceability By Surface 

 
Figure 4.6: Table 3.2 By Surface 

This results table displays the maximum ratios for the various serviceability limit state de-
signs that are decisive for each of the designed surfaces. 

Details on the table columns can be found in the previous chapter 4.4. 
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4.6 Serviceability By Point 

 
Figure 4.7: Table 3.3 By Point 

This table lists the maximum ratios for all FE or grid points of a surface. The different col-
umns are described in detail in chapter 4.4 on page 43. 

In addition to the table rows showing the various serviceability limit state designs, the table 
displays significant values that are considered in the analyses. 

The search function that you can use by clicking the button shown on the left helps you to 
find specific FE or grid points quickly (cf. Figure 5.8, page 57). 
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4.7 Nonlinear Calculation Total 

 
Figure 4.8: Table 3.1 Nonlinear Calculation Total 

This table shows the governing results of the various serviceability limit state designs of all 
surfaces provided for the design. It is subdivided into two parts: The upper part represents a 
design overview in tables. The lower part displays the Intermediate Results of the FE or grid 
point selected above. 

Figure 4.8 shows the results table of a non-linear serviceability limit state design. The design 
method is defined in the Serviceability Limit State tab of table 1.1 General Data (cf. Figure 
2.6, page 11). Chapter 4.4 on page 42 describes the results tables that appear when an 
analytical SLS analysis was carried out. 

Grid Point 
This table column displays the numbers of the FE or grid points for which the program has 
determined the maximum ratios for each required design. The design type is displayed in 
column F Type. 

The FE mesh points are generated automatically. The grid points represent a property of the 
surface that can be set in RFEM. For each surface you can create user-defined results grids. 
For detailed information on grid points, see the RFEM manual, chapter 9.9, page 277. 

Point Coordinates 
These three columns contain the coordinates of the governing FE mesh or grid points. 

Load Case 
Table column E displays the number of the load case or load group whose internal forces 
produce the maximum ratio for the respective serviceability limit state design. 

Type 
Column F shows the type of the serviceability limit state design. If the non-linear method 
was used, the column lists up to four design types. The types are described in detail in the 
German manual RF-BETON Flächen. 
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The individual design types have the following meanings: 

Type Design SLS 

uz,local 
Deformation in cracking sections according to specifications in table 
1.3 Surfaces (see Figure 2.18, page 24) 

wk 
Limitation of crack widths according to specifications in table 1.3 
Surfaces (see Figure 2.13, page 19) 

σc 
Limitation of concrete compressive stress according to specifications 
in table 1.3 Surfaces (see Figure 2.15, page 22) 

σs 
Limitation of reinforcing steel stress according to specifications in 
table 1.3 Surfaces (see Figure 2.15, page 22) 

Table 4.5: Serviceability limit state designs according to non-linear method 

Existing Value 
This table column displays the total extreme values of all surfaces that are decisive for the 
respective serviceability limit state designs. The values of the deformations, crack widths 
and stresses represent the results in cracked sections (state II). 

The crack widths wk listed among the intermediate results in the lower part of the table re-
fer to the reinforcement directions 1 and 2. For example, the value for wk1,top represents the 
crack width of the first reinforcement direction on the top side of the surface (that means 
the crack runs perpendicular to the first reinforcement direction). 

Limit Value 
The limit values result from the standard specifications and the current load situation. The 
determination of limit values is described in detail in chapter 2.4.2 on page 24 as well as in 
the German manual RF-BETON Flächen. 

Ratio 
This column represents the design quotients from the existing value (column G) and the lim-
it value (column H). In this way, you can find out immediately whether the design criterion 
of 1 was fulfilled or exceeded. 

In the background of this table column, colored scales  are displayed whose lengths reflect 
the various design ratios. A green scale means that the design is fulfilled. A red scale indi-
cates an exceeding. To display or hide the scales in the table, use the button shown on left. 

Note 
The final column indicates non-designable situations or notes referring to design problems. 
The numbers are explained in the status bar. 

To display all messages of the currently selected design case, use the [Messages] button 
shown on the left. A dialog box with relevant information appears (cf. Figure 4.2, page 39). 

The buttons in the upper part of the table are described in Table 4.4 on page 44. 



4  Results 

 49 Program RF-CONCRETE Surfaces © 2010 Dlubal Engineering Software 

 

4.8 Nonlinear Calculation By Surface 

 
Figure 4.9: Table 3.2 Nonlinear Calculation By Surface 

This results table displays the maximum ratios for the various serviceability limit state de-
signs that are decisive for each of the designed surfaces. Details on the table columns can 
be found in the previous chapter 4.7. 
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4.9 Nonlinear Calculation By Point 

 
Figure 4.10: Table 3.3 Nonlinear Calculation By Point 

This table lists the maximum ratios for each single FE or grid point of a surface. The differ-
ent columns are described in detail in chapter 4.7 on page 48. 

The search function that you can use by clicking the button shown on the left helps you to 
find specific FE or grid points quickly (cf. Figure 5.8, page 57). 
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5. Results Evaluation 
When the design is completed, several options are available for results evaluation. The de-
sign details, which can be displayed in a separate window, help you to evaluate the data. 
Furthermore, it is possible to evaluate the results graphically in the RFEM work window. 

5.1 Design Details 
When you select to display the results In Grid Points (see Figure 4.1) in the results tables 2.1 
to 2.3 for the ultimate limit state designs, the button [Des.-Details] is enabled. You can use 
this button to look at the design details of the selected grid point, that means the table row 
where the pointer is currently placed. 

The details of the ultimate limit state design are available only if the governing internal 
forces result from one single load case or one single load group. The design of several load 
cases, load groups or of a load combination does not allow for an unambiguous assign-
ment. 

 
Figure 5.1: Dialog box Design Details for ultimate limit state design 

All relevant data is listed in a tree structure on the left. To open a chapter of the tree, click 
[+]. To close a chapter, click [-]. On the right, the dialog box shows the location of the grid 
point in the structure graphically. 

The following design details are displayed: 

• Internal forces of linear statics 
• Principal internal forces 
• Design internal forces 
• Concrete strut 
• Required longitudinal reinforcement 
• Shear design 
• Statically required longitudinal reinforcement 
• Minimum longitudinal reinforcement 
• Necessary longitudinal reinforcement 
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For the serviceability limit state designs, the program shows significant intermediate results 
directly in the tables 3.1 to 3.3 that are subdivided into two parts (cf. Figure 4.5, page 42). 
In addition, you can check all design details for each grid and FE point for the analytical SLS 
design. In contrast to the results of the ultimate limit state designs, the program enables 
now access to the design details of several load cases as well as of load combinations pro-
vided for the design. 

 
Figure 5.2: Dialog box Design Details for serviceability limit state design 

The tree structure displays the relevant result rows for each design type. Use the list Type of 
Proof at the bottom of the dialog box shown above to select the design details that you 
want to display. 

Design method Type of design 

analytical 

σc 

σs 

as,min 

lim ds 

lim sl 

wk 

Table 5.1: Types of Proof for serviceability limit state designs 

Use the button [] to jump to the previous FE or grid point. Click the button [] to select 
the subsequent point.  

see Table 4.3, page 43 
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5.2 Results in the RFEM Model 
To evaluate the design results graphically, you can use the RFEM work window. 

RFEM background graphic 
Use the RFEM graphic in the background to check the location of a particular FE or grid 
point in the model. An arrow in the RFEM background graphic indicates the point that you 
have selected in the results table. 

 
Figure 5.3: Localization of the current FE point in the RFEM model 

If you move the RF-CONCRETE Surfaces window to another place in the display and you still 
cannot see the graphic clearly, use the button [Jump to Graphics] to activate the view 
mode: The RF-CONCRETE Surfaces window will be hidden so that you can modify the dis-
play in the RFEM work window appropriately. The view mode provides only the functions of 
the View menu, for example zooming, moving or rotating the display. 
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Reinforcement direction 

RFEM work window 
It is also possible to visualize the design results and ratios directly in the structural model. 
Use the [Graphic] button to quit the ad-on module RF-CONCRETE Surfaces and access the 
RFEM work window. The window shows all design results and design criteria graphically. 

The Results navigator in RFEM is adjusted to the results from the add-on module RF-CON-
CRETE Surfaces. It provides the results of the longitudinal reinforcements for each rein-
forcement direction and layer, the results of the shear reinforcement, the design internal 
forces as well as various ratios and detail results of the serviceability limit state designs. 

 
Figure 5.4: Results navigator of RF-CONCRETE Surfaces 

To switch the display for the design results on and off, use the toolbar button [Results 
on/off] shown on the left. To display the result values in the graphics, use the toolbar but-
ton [Show Result Values] to the right. 

As the RFEM tables are of no relevance for the evaluation of the RF-CONCRETE Surfaces re-
sults, you may deactivate them. 

The design cases are selected as usual by means of the list in the RFEM menu bar. 

The panel providing the usual control options helps you to evaluate the design results. The 
panel functions are described in detail in the RFEM manual, chapter 4.4.6, page 77. Use the 
Factors tab to scale the surface diagrams of reinforcements, internal forces or ratios. In the 
Filter tab, it is possible to select the results of particular surfaces specifically. 

For the display and evaluation of numerical design results, you can use all options that are 
available in RFEM. The corresponding functions are described in detail in the RFEM manual, 
chapter 10.4, page 306. The following figure, for example, shows the bottom reinforce-
ment that must be inserted additionally to the specified basic reinforcement as a Group. 
The values are applied in direction of the reinforcement. 
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Figure 5.5: Group Bottom Reinforcement, representation of additional reinforcement 

The graphics like RFEM graphics can be transferred to the printout report (see chapter 6.2, 
page 59). 

It is always possible to return to the design module by clicking the button [RF-CONCRETE 
Surfaces] in the panel. 

5.3 Filter for Results 
Due to their arrangement, the results tables of the add-on module RF-CONCRETE Surfaces 
already provide a selection of the total and surfaces maxima. In addition, results tables 2.3 
and 3.3 displaying the design results point by point offer filter options for a specific selec-
tion. 

Filter Points 
In the results tables 2.2 and 2.3 as well as 3.2 and 3.3, the button shown on the left is avail-
able. Use this button to open the dialog box Filter Points. 

 
Figure 5.6: Dialog box Filter Points 
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In the column Surface No., enter the number of the corresponding surface. It is also possi-
ble to select the surface graphically in the RFEM work window. Both functions are available 
as soon as you click into the input field. 

The Points column offers different criteria to filter the results. In addition to All Designable 
and All Undesignable Points, you can select the Governing points. These points provide the 
maximum reinforcement areas or ratios for the respective ultimate or serviceability limit 
state designs. 

If you select the option User defined, you can enter the numbers of the points directly. Click 
All to reset the complete display. 

Display only designable or non-designable results 
By means of the two buttons shown on the left, all designable results or failed designs can 
be displayed exclusively. Use these buttons to hide, for example, failed designs due to sin-
gularities or analyze the reasons for design problems. 

Sorting of Results 
By default,  table 3.1 and 3.2 show the results arranged according to the maximum design 
ratios. The sorting conforms to table column J. To control the maximum values in column G, 
it is possible to sort the results according to the existing values. The maximum ratio of the 
deformation, for example, does not necessarily represent the maximum deformation as the 
limit values can be defined differently surface by surface. Use the [Sorting] button to switch 
between these two types of result arrangement. 

Partial View 
In addition to the functions in the results tables, you can use all filter options described in 
the RFEM manual to evaluate the design results graphically. You can take advantage of al-
ready existing partial views (cf. RFEM manual, chapter 10.9, page 321) used to group ob-
jects appropriately. If necessary, you can create a new partial view for the results of RF-CON-
CRETE Surfaces. 

Section 
In the same way, you can use sections in the RFEM model. It is also possible to define new 
sections to evaluate the results according to your needs (cf. RFEM manual, chapter 10.6, 
page 313). 

Results panel 
In the RFEM work window, you can also use the reinforcement areas and ratios as filter cri-
teria. To apply this filter function, the panel must be displayed. If the panel is not active, 

select Control Panel (Colour Scale, Factors, Filter) on the View menu 

or use the button in the RFEM toolbar shown on the left. 

The panel is described in the RFEM manual, chapter 4.4.6, page 77. The filter settings for 
the design results can be specified in the first panel tab Color Spectrum. The selection of 
surfaces is defined in the Filter tab. 

Use the panel, for example, to define that reinforcement areas are displayed only for a spe-
cific range of values. In Figure 5.7, the lower limit value is 2.00 cm2/m. Moreover, the re-
duced color spectrum has been adjusted so that one color range covers exactly 1.00 cm2/m. 
To limit singularities, the upper value is defined by 9.00 cm2/m. 
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Figure 5.7: Filtering required reinforcement with adjusted color spectrum 

FE node and grid values 
In the results tables 2.2 and 2.3 (reinforcement) as well as 3.2 and 3.3 (serviceability), a 
search function for FE nodes and grid points is available. To use this function, click the but-
ton shown on the left. The following dialog box opens. 

 
Figure 5.8: Dialog box Find Gridpoint 

First, enter the number of the surface or use the [Pick] button to select the surface graph-
ically. Then, enter the number of the relevant gird point or FE node or select the the point 
from the list. 

For the graphical display of the grid point or FE node values, the same control functions as 
used in RFEM are available. The corresponding functions are described in the RFEM manual, 
chapter 10.4, page 306. 
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6. Printout 
 

6.1 Printout Report 
The creation of printouts is similar to the procedure in RFEM. First, the program generates a 
printout report for the RF-CONCRETE Surfaces results. Graphics and descriptions can be 
added. In addition, you can use the print preview to determine the design results that will 
finally appear in the printout. 

When your structure is quite extensive, it is advisable to split the data into several small re-
ports. If you create a separate printout report, for example only for the results of the RF-
CONCRETE Surfaces module, this printout report will be generated relatively quickly. 

The printout report is described in detail in the RFEM manual. In particular, chapter 11.1.3.4 
Selecting Data of Add-on Modules on page 338 provides information concerning the selec-
tion of input and output data in add-on modules. 

A special selection option is available for the intermediate results of serviceability limit state 
designs. The Points column offers different criteria to filter the results. In addition to All De-
signable and All Undesignable Points, you can select the Governing points. These points 
provide the maximum ratios for the respective serviceability limit state designs. 

 
Figure 6.1: Dialog box Printout Report Selection, tab SLS - Analytical Method 
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6.2 Print RF-CONCRETE Surfaces Graphics 
The design graphics can be either integrated in the printout report or sent directly to the 
printer. Printing graphics is described in detail in the RFEM manual, chapter 11.2, page 354. 

Each picture that is displayed in the RFEM work window can be imported into the printout 
report. Even result diagrams of sections can be integrated in the printout report by using 
the [Print] button. 

To print the current RF-CONCRETE Surfaces graphic in the RFEM window, 

select Print on the File menu 

or use the toolbar button shown on the left. 

 
Figure 6.2: Button Print in the toolbar of the main window 

The following dialog box opens: 

 
Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in detail in the RFEM manual, chapter 11.2, page 354. The 
RFEM manual also describes the Options and Color Spectrum tab. 

Every graphic from RF-CONCRETE Surfaces, that has been integrated in the printout report, 
can be moved anywhere within the report by using the drag-and-drop function. 

Furthermore, it is possible to adjust imported graphics subsequently: Right-click the relevant 
entry in the navigator of the printout report and select Properties in the context menu. The 
dialog box Graphic Printout appears again where you can adjust the data appropriately. 
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7. General Functions 
The final chapter describes some menu functions as well as export options for the design 
results. 

7.1 Design Cases in RF-CONCRETE Surfaces 
You can group surfaces in separate design cases. In this way, it is possible to summarize for 
example surface groups or to specify particular types of design (standard, reinforcement, 
non-linear analysis etc.). 

It is important that the surfaces in a reinforcement group of a design case are assigned 
without ambiguity (cf. chapter 2.5, page 27). In contrast, it is no problem to analyze one 
and the same surface in different design cases. 

The design cases of RF-CONCRETE Surfaces are available in the RFEM workspace and can be 
displayed like a load case or load group by means of the toolbar list. 

Create a new RF-CONCRETE Surfaces case 
To create a new design case, 

select New Case on the File menu in the RF-CONCRETE Surfaces add-on module. 

The following dialog box appears. 

 
Figure 7.1: Dialog box New RF-CONCRETE Surfaces-Case 

In this dialog box, enter a No. (which is not yet assigned) and a Description for the new de-
sign case. When you click [OK], table 1.1 General Data opens where you can enter the new 
design data. 

Rename a RF-CONCRETE Surfaces case 
To change the description of a design case subsequently, 

select Rename Case on the File menu in the RF-CONCRETE Surfaces add-on module. 

The dialog box Rename RF-CONCRETE Surfaces-Case appears. 

 
Figure 7.2: Dialog box Rename RF-CONCRETE Surfaces-Case 
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Copy a RF-CONCRETE Surfaces case 
To copy the input data of the current design case, 

select Copy Case on the File menu in the RF-CONCRETE Surfaces add-on module. 

The dialog box Copy RF-CONCRETE Surfaces-Case appears where you can specify the num-
ber and description of the new case. 

 
Figure 7.3: Dialog box Copy RF-CONCRETE Surfaces-Case 

Delete a RF-CONCRETE Surfaces case 
To delete a design case, 

select Delete Case on the File menu in the RF-CONCRETE Surfaces add-on module. 

In the dialog box Delete Cases, select the relevant RF-CONCRETE Surfaces design case in the 
Available Cases list to delete it by clicking [OK]. 

 
Figure 7.4: Dialog box Delete Cases 
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7.2 Units and Decimal Places 
The units and decimal places for RFEM and all add-on modules are managed in one global 
dialog box. In the RF-CONCRETE Surfaces add-on module, you can use the menu to define 
the units. To open the corresponding dialog box, 

select Units and Decimal Places on the Settings menu. 

The program opens the following dialog box that you already know from RFEM. The add-on 
module RF-CONCRETE Surfaces is already preset. 

 
Figure 7.5: Dialog box Units and Decimal Places 

The settings can be saved as user profile to reuse them in other structures. The correspond-
ing functions are described in the RFEM manual, chapter 12.6.2, page 453. 

7.3 Export of Results 
The design results can be provided for other programs in several ways. 

Clipboard 
To copy cells selected in the results tables of RF-CONCRETE Surfaces to the clipboard, use 
the keyboard keys [Ctrl]+[C]. To insert the cells, for example in a word processing program, 
press [Ctrl]+[V]. The headers of the table columns won't be transferred. 

Printout report 
The data of the RF-CONCRETE Surfaces module can be printed into the global printout re-
port (cf. chapter 6.1, page 58) to export them subsequently. In the printout report, 

select Export to RTF File or BauText on the File menu. 

The function is described in detail in the RFEM manual, chapter 11.1.11, page 350. 
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Excel / OpenOffice 
RF-CONCRETE Surfaces provides a function for the direct data export to MS Excel and 
OpenOffice.org Calc. To open the corresponding dialog box, 

select Export Tables on the File menu in the RF-CONCRETE Surfaces add-on module. 

The following export dialog box appears. 

 
Figure 7.6: Dialog box Export - MS Excel 

When you have selected the relevant parameters, start the export by clicking [OK]. Excel and 
OpenOffice will be started automatically. It is not necessary to run the programs in the 
background. 

 
Figure 7.7: Result in Excel 
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CAD programs 
The reinforcement areas determined in RF-CONCRETE Surfaces can also be used in CAD pro-
grams. RFEM provides interfaces to the following programs: 

• Nemetschek (FEM format for Allplan *.asf) 

• Glaser (format *.fem) 

• Strakon (format *.cfe) 

To use this export function, 

select Export on the File menu in RFEM. 

The Export dialog box appears where you can select the relevant interface. The dialog box is 
described in detail in the RFEM manual, chapter 13.5. 

 
Figure 7.8: RFEM dialog box Export 

Depending on the interface, specific options are available for the export of reinforcements. 
To access the corresponding options, use the [Details] button in the Export dialog box. An-
other dialog box opens where you can define specific settings for the interface. 

 
Figure 7.9: Dialog box Detail Settings for Export, results for Glaser 
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